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Sammanfattning 
Syftet med det här projektet var att undersöka om det är möjligt att genom en 
rasteranalys (GIS) av flygbilder (ortofoton) få fram utbredningen av Natura 
2000-naturtypen ler- och sandbottnar som blottas vid lågvatten 
(naturtypskod 1140). Hypotesen var att utbredningen av 1140 motsvaras av de 
pixlar i ett ortofoto som överstiger ett bestämt pixelvärde (brytvärde) i 
havsområdet. I rapporten redovisas hur sådana rasteranalyser kan göras och 
resultaten av dessa. 
 
Olika typer av bilder testades för att undersöka om resultat skilde sig åt 
beroende på vilken typ av bilder man använder som underlag till raster-
analysen. I studien användes svartvita ortofoton, ortofoton i färg och 
satellitbilder (SACCESS). Åtta olika områden i länet besöktes för att bestämma 
utbredningen av 1140 i fält, för att få ett referensmaterial (”facit”). 
 
Det visade sig att variationen i brytvärde både inom och mellan områden var för 
stor för att man ska kunna få fram utbredningen av 114o genom en rasteranalys, 
oavsett vilken typ av bilder man använder. Det fanns heller inte några tydliga 
gradienter som skulle kunna förklara varför brytvärdet varierar, varken när det 
gäller ytter-/inner-områden, sötvattenspåverkan eller exponeringsgrad. Det går 
därför inte att dela upp kusten i olika delområden som analyseras var för sig. 
 
Istället rekommenderas traditionell flygbildstolkning, med ortofoton i färg som 
underlag. Svartvita ortofoton är inte lika tydliga och ger ett för dåligt resultat. 
Satellitbilderna rekommenderas inte heller. De har för grov upplösning (10 x 10 
meter) för att vara användbara. 
 

Summary 
The purpose of this project was to investigate whether it is possible to identify 
areas of the Natura 2000-habitat Mudflats and sandflats not covered by 
seawater at low tide (habitat code 1140), by doing a GIS analysis of aerial 
photographs (orthophotos).  The report describes how such analyzes can be 
made and the results of these analyzes.  
 
Various types of images were tested to determine if the results differed 
depending on the type of images that was used. Eight different areas of the 
county were visited to determine the extent of 1140 in the field, to get a 
reference material.  
 
Unfortunately, the distribution of 1140 cannot be determined by using a raster 
analysis, since the variation in the cut-off value is too large, both within and 
between areas and regardless of the type of images that are used.  
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Instead traditional aerial photo interpretation is recommended. For good 
results, orthophotos in color should be used instead of the black and white 
orthophotos or satellite images.  
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Bakgrund 
Uppdraget från Havs- och vattenmyndigheten 
Länsstyrelsen i Västra Götalands län har fått i uppdrag från Havs- och vatten-
myndigheten (HaV) att baskartera och verifiera Natura 2000-naturtypen ler- 
och sandbottnar som blottas vid lågvatten (1140) i länet. 
 
EU:s art- och habitatdirektiv (Natura 2000) listar ett antal arter och naturtyper 
som ska bevaras och vars bevarandestatus ska övervakas. Naturtypen ler- och 
sandbottnar som blottas vid lågvatten (1140) är en av dem. HaV driver 
tillsammans med Naturvårdsverket (NV) projektet ”Biogeografisk uppföljning 
av naturtyper och arter”, som syftar till att etablera uppföljning för de arter och 
naturtyper där sådan behövs men saknas. ArtDatabanken (ADb) – SLU har på 
uppdrag av HaV och NV rollen att utreda och granska delar av projektet. 
 
Var 6:e år rapporterar Sverige bevarandestatus för alla naturtyper och arter till 
EU, som ska grundas på ett etablerat uppföljningssystem. Syftet med 
uppföljningen är att bidra till att målen med habitatdirektivet och den svenska 
miljöpolitiken kan nås mer effektivt, d.v.s. en gynnsam bevarandestatus för 
berörda naturtyper och arter. 
 
Kunskapen om utbredningen och hur stor yta vi har i landet av flera marina 
naturtyper är dålig. Sverige saknar idag nationella kartor över utbredningen av 
bland annat naturtypen 1140. Det är känt att naturtypen förekommer i de flesta 
län längs kusten och dess areal har uppskattats till cirka 150 km². Den 
bristfälliga kunskapen när det gäller areal och utbredning av naturtyperna 
försvårar beräkning av antal stickprov och kostnader för uppföljning. 
 
Syftet med det här projektet var att undersöka om det är möjligt att genom en 
GIS-analys av ortofoton kartera utbredningen av 1140. Hypotesen var att 
utbredningen av 1140 motsvaras av de pixlar i ett ortofoto som överstiger ett 
bestämt pixelvärde i havet. I rapporten redovisas hur en sådan rasteranalys kan 
göras och resultaten av dessa. Utbredningen av 1140 i länet presenteras också. 
 

Naturtypen ler- och sandbottnar som blottas vid 
lågvatten (1140) 
Definition 
I de svenska tolkningarna av Natura 2000-naturtyper (beslutade av 
Naturvårdsverket 2011-06-13), definieras ler- och sandbottnar som blottas vid 
lågvatten (naturtypskod 1140), eller blottade sand- och lerbottnar enligt 
följande: 

Grunda, sandiga och leriga bottnar som delvis blottas vid lågvatten. 
Dessa bottnar är ofta fria från makrovegetation men med stora 
mängder blågrönalger och kiselalger. Fintrådiga alger kan 
förekomma. 

Naturtypen är viktig för änder och vadarfåglar, som söker föda i de 
grunda bottnarna. Avgränsning mot strand är medelhögvattenstånd. 
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Det lägsta lågvattenståndet avgränsar habitatet mot djupare vatten. 

Figur 1. Naturtypen ler- och sandbotten som blottas vid lågvatten i yttre 
skärgården (norra delen av Nordre älvs estuarium). Foto: Anders Olsson. 

 
I vägledningarna för svenska naturtyper i habitatdirektivets bilaga 1 
(Naturvårdsverket 2011), beskrivs bl.a. avgränsningar mot andra naturtyper, 
viktiga strukturer och funktioner samt typiska arter för naturtypen. 

Viktiga strukturer och funktioner 
Viktiga strukturer och funktioner för naturtypen är: 

• God vattenkvalitet 
• Naturligt vattenutbyte 
• Bottnarna blottas vid lågvatten 
• Naturlig artsammansättning 

Typiska arter 
De typiska arter som man ser mest i länet är följande: 

• skrubbskädda (Platichthys flesus) 
• rödspotta (Pleuronectes platessa) 
• olika arter av stubb (Pomatoschistus sp) 
• hjärtmussla (Cerastoderma edule) 
• sandmussla (Mya arenaria) 
• tusensnäckor (Hydrobia sp) 
• hästräka (Crangon crangon) 
• tångräkor (Praunus sp) 
• sandmask (Arenicola marina) 
• strandskata (Haematopus ostralegus) 

Strandskatan förekommer ofta på de blottade lerbottnarna i länet och är också 
en viktig karaktärsart.  
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Figur 2. I vissa vikar täcks nästan botten av skal av hjärtmusslor (Cerastoderma 
sp). Denna vik är från Malö strömmar. Foto: Anders Olsson. 

 

Avgränsning mot andra naturtyper 
Estuarier (1130), smala Östersjövikar (1650), glasörtstränder (1310) samt salta 
strandängar (1330) har företräde framför ler- och sandbottnar som blottas vid 
lågvatten (1140). 

Naturtypen 1140 i Västra Götalands län 
Naturtypen 1140 finns längs hela kusten i länet, men framför allt i inner-
fjordarna där arealerna kan vara ganska stora. Överlag är bevarandestatusen 
god, även om utbredningen av fintrådiga alger kan bli rätt stor i vissa vikar i 
slutet på sommaren. Att produktionen är stor kan man bland annat se av de 
många hål på botten som bildas av olika typer av grävande organismer (framför 
allt musslor och havsborstmaskar) (figur 3). De ringlande ”korvarna” från 
sandmasken (Arenicola marina) kan ibland vara talrika (figur 4). 
 
Framför allt i fjordarna runt Orust och Tjörn finns det ofta ansamlingar av 
blåmusslor i det grunda vattnet, som på vissa ställen bildar hela bankar 
(biogena rev) (figur 5). Ibland finns det glesa bestånd av nating (Ruppia sp) 
och inte sällan breder ålgräs ut sig utanför naturtypen där vattnet är djupare. 
Naturtypen är viktig som uppväxtområde för plattfisk och som 
födosöksområde för vadare och änder. 
 
1140 finns oftare i områden som är skyddade eller mycket skyddade för våg-
exponering, vilket gör att de är mindre utsatta för lösdrivande alger eller skräp 
som blåser in. 
 
Uppskattningsvis 90 % av naturtypen i länet ligger inom områden som redan 
är skyddade som Natura 2000, naturreservat/nationalpark eller i blivande 
naturreservat. 
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Figur 3. En del bottnar är täckta av hål i olika storlekar från grävande organismer. 
Detta är från en vik i norra Tanumskusten. Foto: Anders Olsson. 

 

Figur 4. Talrika spår av sandmask (Arenicola marina) i Stenungsundskusten. 
Foto: Anders Olsson. 
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Figur 5. Aggregat av blåmusslor som på viss ställen bildar rev (Malö strömmar). 
Foto: Anders Olsson. 

Koppling till Ospar 
Naturtypen är också skyddad i länet genom Ospar-samarbetet (Konventionen 
för skydd av Nordostatlanten), där de hotade naturtyperna Intertidal mudflats 
och Intertidal Mytilus edulis beds on mixed and sandy sediments överlappar 
med 1140. En del av karteringarna av ler- och sandbottnar som blottas vid 
lågvatten 1140 har gjorts inom ramen för Ospar-arbetet, där Länsstyrelsen 
också har uppdrag från Havs- och vattenmyndigheten. 
 

Metodbeskrivning 
Lägsta vattenstånd 
I länet finns tre stationer som registrerar havsvattenstånd varje timme: 
Torshamnen i Göteborg, Smögen samt Kungsvik utanför Strömstad. Uppgifter 
om vilka stationer som finns, vad de mäter och observationer för de senaste 
fyra timmarna finns på SMHI´s hemsida under rubriken Havsobservationer 
(http://www.smhi.se/vadret/hav-och-kust/havsobservationer), som 
uppdateras varje timme. 
 
När arbetet drogs igång under hösten 2013, beställdes utdrag från SMHI för 
samtliga mätningar på de tre stationerna under åren 2010–2012. Exempel på 
sammanställning från Torsviken i Göteborg visas i tabell 1 och figur 6. 
För Göteborg registrerades ett vattenstånd som var lägre än -50 cm vid mindre 
än 1 % av mätningarna (0,63 %). För områdena runt Göteborg bestämdes 
därför att 1140 sträcker sig ner till ett djup av 50 cm under medelvattenstånd. 
För Smögen var motsvarande värde -55 cm (0,71 %) och för Kungsvik -65 cm 
(0,57 %). 

http://www.smhi.se/vadret/hav-och-kust/havsobservationer


Havs- och vattenmyndighetens rapport 2014:17 
 

16 

 
Tabell 1. Frekvens av mätvärden från stationen i Göteborg  
under åren 2010–2012. 

Nivå under medel-
vattenstånd (cm) 

Antal 
registreringar 

Kumulativa 
procenttal 

- 65 0 0,00 % 

- 60 5 0,04 % 

- 55 26 0,25 % 

- 50 47 0,63 % 

- 45 100 1,44 % 

- 40 195 3,02 % 

- 35 364 5,97 % 

- 30 559 10,49 % 

- 25 832 17,22 % 

- 20 1 121 26,30 % 

- 15 1 522 38,62 % 

- 10 2 124 55,81 % 

- 5 2 683 77,52 % 

> -5 2 777 100,00 % 

 

Figur 6. Frekvens av mätvärden från stationen i Göteborg under åren 2010–2012. 
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Fältarbete 
Val av områden 
För verifiering i fält valdes åtta områden ut, varav fem var Natura 2000-
områden som tidigare flygbildstolkats med svartvita ortofoton under bas-
inventeringen 2008. Det var svårt att hitta bra områden för fältverifiering som 
inte redan låg inom ett Natura 2000-område. Av de tre återstående låg ett 
inom ett befintligt naturreservat och två inom blivande naturreservat.  
Bland områdena fanns både objekt som låg inne i fjordområdena och de som 
låg längre ut i kusten, liksom objekt med stor respektive liten sötvattens-
påverkan (tabell 2 och figur 7). 
 
Tabell 2. Områden som besöktes i fält. 
Område N2000 NR Inre fjord/ Yttre kust Sötvattenspåverkan 
Amundön   - 1. yttre kust liten 

Galterö   - 2. yttre kust liten 

Nordre älvs estuarium X X yttre kust stor 

Klåverön X X yttre kust liten 

Stenungsundskusten X X inre fjord liten – måttlig 

Flatön/Malö strömmar  X inre fjord måttlig 

Strömmarna X X inre fjord måttlig 

Tanumskusten X X inre fjord måttlig  

1. Blivande kommunalt naturreservat. 
2. Pågående reservatsbildning inom programmet för skydd av tätortsnära natur (regeringsuppdrag). 

 

Kartunderlag 
Som underlag till fältkartorna användes ortofoton i färg (WMS-tjänst från 
Lantmäteriet) från 2012 och utdrag ur NNK (ytor) som visar var 1140 
registrerades vid basinventeringarna 2008 och 2011 (BIDOS). 

Fältmoment 
Varje timme kontrollerades den senaste vattenståndsregistreringen för den 
närmaste mätstationen på SMHI´s hemsida (http://www.smhi.se/vadret/hav-
och-kust/havsobservationer). Om vattenståndet var -17 cm och 1140 var 
definierad i området att gå ut till ett djup av 50 cm vid medelvattenstånd, 
mättes var någonstans i den aktuella viken djupet var 33 cm (50–17 cm), 
genom att gå med båten utifrån och in på jämna avstånd. Som djupmätare 
användes ett måttband som satt fast på en båtshake (figur 8). Varje mätpunkt 
registrerades med hjälp av en handhållen-GPS. I ett protokoll angavs följande 
för varje vik: 

• lokalnamn + löpnr 
• Waypoints-intervall (GPS-punkternas nr) 
• datum och tid 
• provtagare 
• aktuellt vattenstånd och tid för registrering 
• bottensubstrat 
• förekomst av blåmusselaggregat/blåmusselbankar (täthet och position) 
• kort beskrivning av förekommande arter och allmän status i viken 

http://www.smhi.se/vadret/hav-och-kust/havsobservationer
http://www.smhi.se/vadret/hav-och-kust/havsobservationer
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Figur 7. Områdenas lokalisering i Västra Götalands län. 

 

Figur 8. Mätning i fält av hur långt ut 1140 sträcker sig (Galterö utanför Göteborg). 
Foto: Maria Kilnäs. 
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Rasteranalys 
Digitalisering av fältdata 
GPS-punkterna importerades till ArcMap-projektet med hjälp av tillägget 
”MxGPS” (Tools > Extensions). Som kartunderlag användes Vattenskiktet i 
Lantmäteriets Fastighetkarta. Ytan för 1140 klipptes sedan ut längs med GPS-
punkterna. Använd ”Snapping-funktionen” (Editor > Snapping). 

Val av rasterbilder till analysen 
Basinventeringarna av Natura 2000-naturtyper som gjordes under 2008 och 
2011 byggde i stort sett på tolkningar av svartvita ortofoton. När tolkningarna 
jämfördes med de uppmätta ytorna i fält i år, var skillnaderna ganska stora på 
många ställen. Om man däremot jämförde de uppmätta ytorna med ljusare 
partier på de digitala ortofoton i färg som länsstyrelserna numera har tillgång 
till, blev överensstämmelsen mycket bättre. 
 
Problemet är att länsstyrelserna bara har ortofoton i färg från Lantmäteriet 
som en WMS-tjänst, vilket innebär att man enbart kan titta på bilderna och ha 
dem som underlag vid en flygbildstolkning men att det inte går att göra några 
analyser på dem. En länsstyrelse kan däremot beställa enskilda foton/grupper 
av foton (5 x 5 km) från Lantmäteriet utan kostnad annat för en eventuell 
hårddisk, vilket gjordes för det här projektet.  
 
För att undersöka om tillgängliga bilder kunde användas istället, gjordes också 
jämförelser mellan två andra typer av bilder: 

• Flygbilder – Ortofoto (sv/v), 0,5 x 0,5 meter 
• Satellitbilder (Saccess), 10 x 10 meter 

Analys av ortofoton/satellitbilder 
Syftet var att se om det är möjligt att 1140 motsvaras av de pixlar i ett ortofoto 
som överstiger ett bestämt pixelvärde. Förhoppningen var att detta pixelvärde 
(det så kallade brytvärdet) skulle vara lika stort i alla områden i länet eller att 
man skulle hitta tydliga mönster för hur det varierade. 
 
Det blir väldigt tungt att arbeta med bildfiler om man arbetar mot ett nätverk 
och inte har en väldigt stark dator. Om området är lite större går det inte att 
arbeta med hela området på en gång, utan man måste dela in det i mindre 
delområden, så att skalan på skärmen motsvarar ca 1:15 000 – 1:20 000. Detta 
gäller även om man sparar filerna på sin hårddisk. 
 
I korthet görs analysen på följande sätt: 

1. En bit av ortofotot klipps ut och sparas på hårddisken. 
2. Färgbilder görs om till svartvitt. 
3. Vilket ”brytvärde” programmet ska jobba med bestäms genom att 

klicka runt inom och utanför en 1140-yta.  
4. Med hjälp av Spatial Analyst > Raster Calculator bildas en temporär fil 

där alla pixlar som har ett värde lika med eller högre än det föreslagna 
brytvärdet ges ett värde av 1 och övriga pixlar får värdet 0. Detta görs 
för flera närliggande brytvärden för att se vilket som bäst stämmer med 
de fältverifierade ytorna i området. 

5. Den fil som stämmer bäst konverteras till en shape-fil. 
6. Alla ytor med värdet 0 klipps bort. 



Havs- och vattenmyndighetens rapport 2014:17 
 

20 

7. Alla ytor som ligger på land klipps bort med hjälp av fastighetskartans 
vattenskikt. 

8. Alla ytor <500 m² klipps bort, för att få bort brus i form av bryggor, 
stenar, smala strandkanter m.m. 

9. Alla delområden för ett område läggs ihop till en gemensam fil.  

För detaljerad beskrivning, se bilaga 1. Instruktion till rasteranalys. 
 

Flygbildstolkning 
Eftersom brytvärdet i rasteranalysen varierar såväl mellan områden som inom 
samma område, togs beslutet att istället flygbildstolka alla 1140-ytor i länet 
med ortofoton i färg som grund (Lantmäteriets WMS-tjänst). De ljusare 
partierna som man tolkar som 1140 i färg-ortofotona överensstämmer mycket 
bättre med de fältkontrollerade områdena, än ljusare partier i svartvita 
ortofoton eller satellitbilder. De fältkontrollerade områdena användes som 
träningsområden.  

Metodbeskrivning 
1. Som underlagsdata används Lantmäteriets ortofoton i färg (WMS-

tjänst). Man kan med fördel också ha med tidigare års ortofoton i 
färg (LM Ortofoto årsvis (VMS-tjänst)) som jämförelse där man är 
osäker. Det är också bra att jämföra med ett utdrag ur NNK med 
tidigare tolkade ytor av 1140.  
Andra underlag som kan vara bra att ha med är Sjöfartsverkets 
rastersjökort eller Lantmäteriets Terrängkarta, för att identifiera 
områden grundare än 6 meter samt ett skikt med Natura 2000-
områdena. 

2. Man utgår från Lantmäteriets Fastighetskarta i vektorformat, där 
man använder det skikt som heter Vatten. Man markerar den del av 
skiktet som man ska arbeta med och sparar denna del på sin egen 
dator/server (Data > Export Data). Markera sedan alla ytor i det nya 
skiktet (Selection < Select All) och slå ihop dem till en yta (Editor > 
Merge). 

3. Gör skiktet ihåligt, så att man enbart ser konturen av ytan. 
4. Lämplig skala att arbeta i är 1:1 500 – 1:3 000. 
5. Man klipper ut grunda delar där färgen är betydligt ljusare än 

omgivande vatten. På västkusten med mycket lerbottnar är oftast 
inte de halvljusa partierna så grunda som 1140 (se figur 9).  
Detta gör man genom att välja Editeringsläget (Editor > Start 
Editing) och välja den mapp där kopian av fastighetskartan Vatten 
ligger. 
Markera ytan och använd funktionen (”Task”) ”Cut Polygon 
Features” och verktyget ”Sketch Tool”. 

6. Minsta karteringsyta är lämpligtvis 0,25 ha, dvs. ytor som är mindre 
än 0,25 ha bortser man ifrån. 

7. Man får vara lite observant där större vattendrag mynnar ut, vilket 
ofta kan grumla vattnet som lurar en att tro att det är bottnen man 
ser fast det bara är en uppgrumling av vattnet. Speciellt gäller detta 
där botten består av lersediment. 

8. Man får också hjälp av topografin. Branta, exponerade stränder har 
sällan anslutande grunda ler- och sandbottnar. 

9. Ändra ”Detaljtyp” i attributtabellen från ”VATTEN” till ”1140” för 
den nya ytan som bildas. 
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10. Glöm inte att spara med jämna mellanrum. 
11. Om det tar lång tid för programmet att avsluta en ”klippning”, kan 

man dela upp kusten i flera delytor. 

 

Figur 9. Exempel på flygbildstolkning av ler- och sandbottnar som blottas vid 
lågvatten (1140). Observera att ”halvljusa” partier inte har tagits med.  
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Resultat och diskussion 
Vilka underlag är mest lämpliga att använda vid 
fjärranalys av naturtyp 1140? 
Flygbilder 
Både i fält och vid registreringen av ytorna i ArcMap upptäcktes att ytorna från 
NNK-skiktet (basinventeringarna) i vissa fall skilde sig relativt mycket från det 
som registrerades i fält, men också från det som såg ut som 1140 på färg-
ortofotot (figur 10). Detta gällde oberoende vem som hade tolkat 1140 vid 
basinventeringarna. Det visade sig att det berodde på att de svartvita ortofoton 
som tidigare använts vid basinventeringarna är väldigt ojämna, både i kvalitet 
och i ljusstyrka mellan enskilda foton. Det kan också vara stora variationer 
inom en bild vilket kan vara skuggeffekter. 
 

Figur 10. En jämförelse mellan svartvita ortofoton (till vänster) och de i färg (till 
höger). På färgbilden syns naturtypen tydligt som ett ljusare fält medan bara de 
allra grundaste områdena framträder på den svartvita bilden. På bilderna syns 
också de tolkningar av naturtyp 1140 som gjorts tidigare med de svartvita 
ortofotona som bakgrund (utdrag ur NNK, svart streckad linje) och ytorna som 
uppmättes i fält (röd heldragen linje). 
 
Men även för ortofoton i färg och satellitbilder är det svårt att hitta ett 
gemensamt pixelvärde som brytvärde för 1140 inom samma område (figur 11).  
Det är också en stor variation i brytvärde mellan olika områden (tabell 3).  
Rasteranalysen är dessutom ganska tidskrävande, om man inte har en väldigt 
kraftfull dator. Varje ortofoto (5 x 5 km) måste analyseras för sig. Med tanke på 
att flygbildstolkning med ortofoton i färg verkar väldigt lovande (figur 10), 
rekommenderas istället en heltäckande flygbildstolkning, även om den är 
subjektiv.  
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Tabell 3. En jämförelse mellan olika brytvärden (pixelvärden) för 
naturtyp 1140 med olika typer av bilder. 

Typ av bilder Brytvärde Upplösning 

Flygbilder – Ortofoto färg  2012 >= 95–140 1 x 1 meter 

Flygbilder – Ortofoto (sv/v) >= 82–125 1 x 1 meter (0,5 x 0,5 
meter) 

Satellitbilder (Saccess), naturliga 
färger >= 100–145 10 x 10 meter 

 
 

Figur 11. En jämförelse mellan fältkontrollerade ytor av naturtyp 1140 
och en rasteranalys byggd på ortofoton i färg, där avvikelserna 
är stora (Stenungsundskusten S).  
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Bestämning av naturtyp 1140 med hjälp av djupdata 
Det hade det varit relativt enkelt att söka ut 1140 om man hade haft tillgång till 
heltäckande djupdata med bra upplösning, liknande höjddatabasen som finns 
för land. Då hade man enkelt kunnat klippa ut de områden som blottas vid 
lågvatten i olika områden, med hjälp av vattenståndsdata från SMHI. Man 
hade bara behövt ta hänsyn till att lägsta lågvattennivån varierar längs med 
kusten.  
I dagsläget saknas dock heltäckande djupdata över landets grunda havs-
områden. Dessutom brottas länsstyrelserna och andra myndigheter fortfarande 
med den omfattande sekretessen som rör djupdata, trots att Försvarsmakten 
inte säger sig ha några intressen i grundområden 0–6 meter. 
 
LIDAR och multibeamekolod 
Problemet är att det är svårt att mäta både med multibeamekolod och med 
LIDAR i så grunda miljöer, även om problemet med ett litet djup har blivit 
mindre med den nyaste AHAB Lidarn (J. Berglund muntl.). Bildtolkning av 
grunda miljöer ger fortfarande ett bättre resultat (G. Lysell muntl.). Båda dessa 
metoder är dessutom fortfarande väldigt kostsamma. Hittills har de mindre 
mätningar som gjorts med LIDAR kostat mellan 8 000–28 000 kr per km2. 
Generellt sett blir det dyrare per km2 ju mindre område man mäter och ju lägre 
man flyger. Detta kan jämföras med den här fältkarteringen, där motsvarande 
kostnad var ca 10 000 – 15 000 kr per km2. Men vid fältkartering får man även 
in annan typ av data, t.ex. förekommande arter och en uppskattning av 
bevarandestatusen. 
 
Nationella djupdatabasen 
Efter digitaliseringen av gamla lodningar, täcker mätdata från den nationella 
djupdatabasen en stor del av kusten. På de allra grundaste områdena är 
däremot mätpunkterna betydligt glesare och det går tyvärr inte använda dessa 
för att avgränsa 1140 (figur 12). 
 

Tabell 4. Variationer i brytvärde mellan olika områden och med olika bilder. 
Område ortofoto färg S/V ortofoto satellitbild 
Tanumskusten >=95 >=90 >=130 

Klåverön >=100 >=82 >=125 

Amundön >=112 >=100 >=105 

Galterö >=112 >=100 >=105 

Stenungsundskusten N >=115 >=115 >=125 

Stenungsundskusten S >=130 >=125 >=145 

Flatön >=130 >=90 >=105 

Nordre älvs estuarium >=135 >=105 >=100 

Strömmarna >=140 >=110 >=120 
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Figur 12. Mätpunkter från den nationella djupdatabasen, i 
delar av Tanumskusten i norra Bohuslän där sekretessen är 
hävd. Röda punkter är djup grundare än 0,65 meter, gula 
punkter är djupare. 

 

Rasteranalys 
Variationer mellan områden 
Ett område som får ett jämförelsevis högt brytvärde vid användningen av en 
typ av bilder, kan få ett jämförelsevis lågt brytvärde vid användning av ett en 
annan typ av bilder, vilket visar på att ljusintensiteten hos de enskilda bilderna 
kan variera mycket (tabell 4). 

Färgen på bilderna blir ljusare om man kan se ner till botten. Men områdena i 
ytterskärgården i denna studie har generellt sett ett lägre brytvärde (mörkare), 
med undantag för Tanumskusten (tabell 5 och 6). Det borde vara tvärtom, 
eftersom man oftast kan se botten djupare ner längre ut från kusten där vattnet 
är klarare, vilket har noterats i andra områden tidigare. 

Det blir ofta grumligare i vattnet där sötvatten rinner ut, vilket kan ge bilderna 
en ljusare färg där och indikera att man kan se botten fast man inte kan det. I 
de områden där sötvattentillförseln inte är jämnt spridd, blev det svårare att 
hitta ett gemensamt brytvärde och det var större variationer inom områdena.  
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Tabell 5. Olika parameters påverkan på brytvärdet (ortofoton i färg). 
Parameter Påverkan Kommentar 
ortofotonas  årtal nej Alla bilder är tagna samma år (2012). 

yttre kust – inre fjord delvis Med undantag för Tanumskusten som avviker. 

vågexponering nej Alla 1140 är inom skyddat – mycket skyddat. 

sötvattenspåverkan ja 
Inte i storleken på brytvärdet, men det ger större 
svårigheter att hitta ett gemensamt brytvärde inom ett 
område. 

norr – söder  nej 
De som ligger längst ifrån varandra har samma, låga 
värde. Områdena med låga resp. höga värden ligger 
relativt nära varandra. 

skillnader mellan enskilda foton ja Ljusintensiteten varierar mellan olika foton. 

 

Tabell 6. Variationer i brytvärde (ortofoton i färg) mellan olika områden och i 
relation till olika fysiska parametrar. 

Område 
Bryt-
värde 

Inre fjord/ 
Yttre kust Vågexponering 

Sötvattens-
påverkan 

Tanumskusten 95 inre fjord extremt skyddad måttlig, jämn 

Klåverön 100 yttre kust skyddad/ mycket 
skyddad liten 

Amundön 112 yttre kust mycket skyddad liten 

Galterö 112 yttre kust skyddad liten 

Stenungsundskusten N 115 inre fjord skyddad liten 

Stenungsundskusten S 130 inre fjord skyddad måttlig, jämn 

Flatön 130 inre fjord mycket skyddad måttlig, jämn 

Nordre älvs estuarium 135 yttre kust mycket skyddad stor, ojämn 

Strömmarna 140 inre fjord extremt skyddad måttlig, jämn 

 

En jämförelse mellan fältbesök och fjärranalys  
Rasteranalys 
Det ser bra ut på pappret att den sammanlagda arealen av 1140 i ett område vid 
rasteranalysen är nära 100 % av den uppmätta arealen i fält (tabell 7), men 
variationen kan vara väldigt stor mellan olika vikar inom ett område. I en del 
vikar underskattas arealen, medan den överskattas i andra (figur 11). 
Det är också en relativt stor spridning i brytvärdet mellan olika områden. Det 
gör att man inte kan välja ett gemensamt brytvärde för hela länet, vilket var 
förhoppningen när det här projektet startade (tabell 7). 
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Tabell 7. Brytvärden för olika områden och en jämförelse mellan arean av 1140 
vid aktuellt brytvärde och den uppmätta arealen i fält. 

Område 
Brytvärde ortofoton 
i färg Areal 1140 (%)* 

Tanumskusten 95 100,2 

Klåverön 100 101,1 

Amundön 112 100,4 

Galterö 112 98,1 

Stenungsundskusten N 115 104,2 

Stenungsundskusten S 130 103,0 

Flatön 130 102,8 

Nordre älvs estuarium 135 98,5 

Strömmarna 140 101,9 

 

Flygbildstolkning 
De tolkningar av 1140 som tidigare gjorts med svartvita ortofoton som 
bakgrund (till exempel i NNK), skiljer sig i många fall från de ytor som 
uppmättes i fält. Med ortofoton i färg blir träffsäkerheten i tolkningarna mycket 
bättre (figur 10).  
Nackdelen med flygbildstolkning är däremot att det är just en tolkning och inte 
alltid stämmer med verkligheten. Det är i vissa fall stora skillnader mellan olika 
bilder. Skillnaderna mellan olika tolkare varierar också, trots att man har stämt 
av med varandra innan. 

Kostnader och tidsåtgång för flygbildstolkning 
Uppstartstiden för flygbildstolkningen är ca 2 h. Tolkningen av 1140 i Västra 
Götalands län tog ca 110 h effektiv tid. Havsstrandlinjen i länet är 3 242 km 
enligt Översiktskartan, vilket ger en genomsnittlig tid på ca 30 km per timme. 
Kostnaden för flygbildstolkningen av hela länet blev ca 60 000 kr totalt.  
I jämförelse karterades ca 1,6 km per timme i fält av två personer inklusive 
transporter (0,8 km per persontimme). Men eftersom man inte åker ut planlöst 
i fält, utan först scannar av om det kan finnas 1140 i området, kan man inte 
multiplicera denna kostnad med hela strandlinjens längd för att få 
totalkostnaden. 
 

Utbredningen av naturtyp 1140 i Västra 
Götalands län 
Antalet ytor i Västra Götalands län är ca 1 071 stycken med en sammanlagd yta 
på ca 3 239 ha (32 km2). Av dessa ligger 43 % (463 stycken) inom ett Natura 
2000-område (figur 13). Ytterligare 4 % (47 stycken) ligger inom ett befintligt 
naturreservat.  
Den sammanlagda ytan inom Natura 2000-områdena uppgår till ca 1 867 ha, 
vilket motsvarar 58 %. Den största ytan är Galtö lera i Tanumskusten med 123 
ha. 
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Figur 13. Utbredningen av ler- och sandbottnar som 
blottas vid lågvatten (1140) i länet. Blå punkter: naturtyp 
1140 inom Natura 2000-områden, röda punkter: naturtyp 
1140 utanför Natura 2000-områden.  
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Slutsatser och rekommendationer 
Till de på länsstyrelserna som ska kartera naturtyp 1140 
• Med dagens förutsättningar är flygbildstolkning, med ortofoton i färg 

som underlag, det bästa sättet att kartera 1140 om man ska kartera större 
områden. 

• Om man är intresserad av utbredningen i ett specifikt område, eller det 
är viktigt att få en exakt utbredning av 1140, bör man kartera 1140 i fält. 
Då får man också en bild av bevarandestatusen i habitatet. 

• Ska man ändå åka ut i fält för att kartlägga bevarandestatusen, bör 
utbredningen också karteras i fält. 

• Använd inte svartvita ortofoton vid flygbildstolkning eller analys av 1140, 
de har för ojämn kvalitet.  

• Använd inte satellitbilder (Saccess) vid flygbildstolkning eller analys av 
1140, de har för dålig upplösning (10 x 10 meter). 

• Var försiktig med att analysera fram 1140 genom rasteranalyser av 
ortofoton. Variationerna kan vara stora både mellan och inom områden. 

Till Havs- och vattenmyndigheten och länsstyrelserna som 
myndigheter 
• Verka för att det tas fram en djupdatabas med motsvarande kvalitet som 

höjddatabasen på land. Då kan man relativt enkelt få fram en sann bild 
av utbredningen av 1140. 

• Verka för att sekrettesen hävs för djupdata, så att den blir allmänt 
tillgänglig. 

• Verka för att utdrag från djupdatabasen kan göras för en mindre kostnad. 

• Se till att alla länsstyrelser har tillgång till ortofoton i färg som 
rasterbilder och inte bara som en WMS-tjänst. 
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Bilaga 1. Instruktion till 
rasteranalys 
1. En bit av ortofotot klipps ut och sparas på 

hårddisken. 
Skapa en ny mapp på hårddisken (B:), som du samlar all data i. 
Skapa en filgeodatabas på B: i ArcCatalog, genom att högerklicka på mappen 
ovan > New > Personal Geodatabase. 
Zooma in arbetsytan till åtminstone 1:20 000, vilket blir en ganska stor fil som 
ändå funkar att jobba med. Skala 1:15 000 blir lite behändigare.  
Lägg till ortofoton/satellitbilder med blått plus. 
Högerklicka på skiktets namn > Data > Export data. 
”Ändra till Data Frame (Current)” på två ställen. Ändra ”Cell Size (cx, cy)” till 1 
x 1 också för de svartvita ortofotona, annars blir filen för tung. Satellitbilderna 
har dock upplösningen 10 x 10. 
Namnge och spara utan filändelse i databasen. Du bör nu ha fått en ny bild. 
Tänd den och släck den stora bilden.  
För svartvita ortofoton: Högerklicka på namnet på det nya skiktet > Properties 
> Symbology, sätt ”Stretch Type” till None. 

2. Färgbilder görs om till svartvitt. 
För ortofoton i färg och satellitbilder: Högerklicka på namnet på det nya skiktet 
> Properties > Symbology, ändra ”Show:” till Stretched och sätt ”Stretch Type” 
till None. 

3. Bestäm brytvärde 
Bestäm vilket ”brytvärde” programmet ska jobba med genom att klicka runt 
inom och utanför en 1140-yta. Vilket lägsta pixelvärde verkar indikera 1140? 

4. Maska ut de pixlar som är större eller lika med 
brytvärdet 

Använd Spatial Analyst1 >Raster Calculator, dubbelklicka på nya ortofotot i 
”Layers” >= och skriv in det tidigare bestämda brytvärdet. Klicka på ”Evaluate”. 
Ett nytt, temporärt skikt skapas, där alla pixlar som har ett värde lika med eller 
högre än det föreslagna brytvärdet ges ett värde av 1 och övriga pixlar får värdet 
0. Detta görs för flera närliggande brytvärden för att se vilket som bäst 
stämmer med fältytorna i området. Ge varje temporär fil namn efter det 
brytvärde som testas, annars är det svårt att komma ihåg vilken som är vilken. 

                                                           
1 Plockas fram från View > Toolbars. Kan behöva aktiveras genom Tools > Extensions. 
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5. Den fil som stämmer bäst konverteras till en 
shape-fil. 

Spatial Analyst1 > Convert > Raster to feature…, välj det nya, temporära 
skiktet, bocka ur ”Generalize lines” och spara som en shapefil. 

6. Alla ytor med värdet 0 klipps bort. 
Starta editering på shapen (Editor > Start Editing, välj rätt shape-fil under 
”Target:”) och ta bort alla områden med 0 i kolumnen GRIDCODE (m.h.a. 
Selection > Select by attributes… > ”GRIDCODE = 0” > OK. Välj Edit > Delete). 

7. Ta bort alla ytor på land. 
Lägg till fastighetskartans vattenskikt m.h.a blått plus. 
Använd Arc Toolbox > Analysis Tools > Extract > Clip, välj shapen som ”Input 
Feature” och vattenskiktet som ”Clip Feature”, namnge (”Output Feature 
Class”), klicka OK. 

8. Gör egna polygoner av varje yta. 
Ibland kan olika ytor ha bildat en gemensam polygon, fastän de inte sitter ihop. 
Detta åtgärdas genom att slå isär polygoner (XTools Pro2 > Feature 
Conversions > Convert Multipart Shapes to Single Parts, välj rätt ”Input feature 
layer” och ange var det nya skiktet ska sparas.) 

9. Ta bort brus i form av bryggor, stenar m.m. 
Alla ytor <500 m² klipps bort, genom att först beräkna arealen för varje yta 
(XTools Pro2 > Table Operations > Calculate Area, Perimeter…, välj rätt skikt, 
sätt ”Desired output units” till ”Meter”, bocka ur alla utom ”Area”.) 
Gå sedan in på Selection > Select by attributes… > “Area < 300” > OK. Välj Edit 
> Delete). 

10. Alla delområden för ett område läggs ihop till 
en gemensam fil.  

Använd Arc Toolbox > Data Management Tools > General > Merge, välj de 
shape-filer som ska slås ihop som ”Input Datasets”, namnge (”Output dataset”), 
klicka OK. 

11. Ta bort filer som inte behövs. 
Rensa bort egenskapade ortofoton, tillfälliga skikt som t.ex. den första shapen 
(som sedan klipps mot vatten) från både projektfilen (.mxd), mappen och 
databasen på B:, så att bara den slutliga, klippta shapefilen återstår. 

                                                           
2 Kan behöva aktiveras genom Tools > Extensions. 
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